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BAB II
Landasan Teori

2.1. Tinjauan Umum

Rental Wahana Disc merupakan salah satu usaha persewaan VCD yang didirikan pada awal tahun 2002, sehingga salah satu usaha pribadi yang berada di jalan kaliurang Yogyakarta

Mengigat perkembangan dunia hiburan saat ini sangat pesat dan semakin maju maka persaingan antar usaha yang satu dan yang lain sangat terasa, dalam penyewaan VCD yang membutuhkan suatu kemajuan. Dalam perkembangan rental VCD selalu berusaha meningkatkan pelayanan terhadap konsumen, karena usaha ini tidak lepas dari pelayanan yang diberikan terhadap pelanggan.

Untuk inilah rental Wahana Disc sebagai salah satu usaha persewaan VCD, berusaha untuk memberikan pelayanan sebaik mungkin yaitu dengan mengganti sistem pengolahan data secara manual yang dijalankan selama ini dengan sistem pengolahan data yang berkomputerisasi. Sistem pengolahan data yang akan digunakan tersebut mengutamakan sistem informasi pencarian VCD. Dengan begitu, akan mempermudah semua pihak terutama pihak pengelola dan dari pihak konsumen akan terlayani dengan capat karena akan mendapatkan informasi tentang keberadaan VCD yang dibutuhkan secara cepat dan tepat.

Pada penyewaan VCD di rental Wahana Disc, jenis cd yang yang ditawarkan terdiri dari berbagai jenis, untuk jenis film diantaranya adalah film actor, komedi, drama, dan lain – lain. Adapula berbagai jenis Game dan berbagai jenis cd softwere.
Harga sewa VCD yaitu diantaranya Rp. 1000,- sampai Rp. 3000,- yaitu Rp. 1000,- untuk cd copian, Rp. 2500,- untuk cd copian original dan Rp. 3000,- untuk yang asli (Original). Namun tidak menutup kemungkinan harga dapat berubah, ini tergantung kondisi, batas pinjaman  cd adalah tiga hari. Jika pengembalian terlambat dari tanggal yang telah ditentukan maka akan dikenakan denda sesuai harga sewa cd untuk setiap keping cd. Dan jika ada yang rusak ataupun hilang yang disebabkan oleh si peminjam, juga akan dikenakan denda.   

2.2. Konsep Dasar Sistem

Ada dua pendekatan sistem, yaitu pendekatan elemen dan pendekatan prosedur. Pengertian sistem di tinjau dari pendekatan elemen yaitu kumpulan dari elemen – elemen yang berinteraksi satu sama lain untuk mendukung tercapainya tujuan tertentu. (Jogiyanto. H.M Analisis dan Desain Sistem Informasi 1999 )
Pengertian sistem ditinjau dari pendekatan prosedur yaitu suatu jaringan kerja dan prosedur – prosedur yang saling berhubungan, berkumpul bersama – sama untuk melakukan suatu kegiatan untuk menyelesaikan suatu kegiatan untuk menyelesaikan suatu sasaran tertentu.

Suatu sistem harus mempunyai sifat, syarat atau karateristik sistem, dimana syarat suatu sistem adalah
a. Komponen
Yaitu suatu sub sistem atau bagian dari sistem, dimana suatu sub sistem mempunyai sifat – sifat dari sistem yang menjalankan sifat fungsi tertentu dan mempengaruhi proses sistem secara keseluruhan. Dan suatu sistem dapat mempunyai suatu sistem yang lebih besar
b. Batas 

Adalah sesuatu yang membatasi antara satu sistem dengan sistem yang lain atau sub sistem yang satu dengan sub sistem yang lain.
c. Luar

Merupakan lingkungan luar apapun di luar batas dari sistem yang di pengaruhi maupun yang mempengaruhi sistem. Dimana lingkungan luar sistem dapat bersifat menguntungkan dan dapat pula bersifat merugikan sistem tersebut.
d. Penghubung

Adalah suatu yang menghubungkan antara sistem yang satu dengan sistem yang lain atau subsistem dengan sub sistem yang lain
e. Input System (Masukan Sistem)

Adalah energi yang diolah untuk menghasilkan keluaran input di bagi menjadi 2 yaitu :
· Signal Input atau Sinyal :

          
Adalah energi yang di proses untuk mendapatkan keluaran.
· Maintenance Input atau Perawatan.

Adalah energi yang di masukkan agar sistem tersebut dapat beroperasi.

f. Output System (Sistem Keluaran)
Merupakan hasil energi yang diolah dan diklasifikasikan menjadi keluaran yang berguna dan keluaran yang tidak berguna.
g. Ojectives atau Goal (sasaran sistem atau tujuan)
Suatu sistem pasti mempunyai sasaran atau tujuan. Dimana sasaran dari sistem sangat menentukan sekali masukan yang dibutuhkan sistem serta keluaran yang dihasilkan sistem. Suatu sistem dikatakan bila mengenai sasaran dan tujuan.
2.3. Konsep Dasar Informasi

Informasi sangat penting dalam suatu organisasi. Suatu sistem yang kurang mendapatkan informasi akan menjadi luruh, kerdil dan akhirnya berakhir karena kurang mendapatkan informasi. Informasi dapat didefinisikan sebagai berikut :

Informasi adalah data yang diolah menjadi bentuk yang lebih berguna dan lebih berarti bagi yang menerimanya (Jogiyanto. H.M Analisis dan Disain Sistem Informasi 1999). 
Sumber dari informasi adalah data. Data adalah bentuk jamak dari bentuk tunggal data item. Data adalah kenyataan yang menggambarkan suatu kejadian – kejadian dan kesatuan nyata. Kejadian – kejadian (event) adalah suatu yang terjadi pada saat tertentu. 
2.4. Konsep Dasar Sistem Informasi

Informasi merupakan hal yang sangat penting bagi manajemen untuk mengambil keputusan. Informasi dapat diperoleh dari sistem informasi atau disebut juga processing system atau information generating system. 
Sistem informasi adalah suatu sistem didalam suatu organisasi yang mempertemukan kebutuhan pengolahan transaksi harian, mendukung operasi, bersifat manajerial dan kegiatan strategi di suatu organisasi (Jogiyanto. H.M Analisis dan Disain Sistem Informasi 1999) 

2.5. Konsep Basis Data

Basis Data merupakan bagian yang erat hubungannya dan bahkan tidak dapat dipisahkan lagi dengan kebutuhan si pemakai komputer. Basis Data adalah kumpulan dari data yang saling berhubungan satu dengan yang lainnya. 
Basis Data yang baik harus tersusun dalam satu struktur tertentu dan data yang ada terhubung dengan alur yang jelas sehingga memudahkan dalam pengaksesan dan manajemen dari data yang ada pada Basis Data tersebut.
2.5.1. Normalisasi


Dalam perancangan Basis Data, normalisasi merupakan langkah yang perlu dilakukan guna mempermudah dalam mendesain suatu basis data. Normalisasi merupakan suatu teknik dalam logical desain sebuah basis data, teknik pengelompokkan atribut dari suatu relasi sehingga membentuk struktur relasi yang baik (tanpa redudansi).
1. Normalisasi Pertama.

Aturan:

· Dengan mendefenisikan atribut kunci dari tabel data pada basis data

· Tidak adanya group yang berulang

· Semua atribut bukan kunci tergantung pada atribut kunci.

2. Normalisasi Kedua

Aturan:

· Sudah memenuhi dalam bentuk normal kesatu

· Sudah tidak ada ketergantungan parsial, dimana seluruh field hanya tergantung pada sebagian field kunci.

3. Normalisasi Ketiga

Aturan: 

· Sudah dalam bentuk normal kedua
· Tidak ada keterganungan transitif (dimana field bukan kunci, tergantung pada field bukan kunci lainnya).
2.5.2. Relasi Antar Tabel

Dalam perancangan Basis Data terdapat hubungan-hubungan yang terjadi antar tabel, hubungan-hubungan antar tabel tersebut adalah :

1. Hubungan One to One
Hubungan ini adalah hubungan antara satu tabel induk yang dihubungkan dengan satu tabel anak yang lainnya, yang dihubungkan berdasarkan atribut kunci yang terdapat pada masing-masing tabel. 

2. Hubungan One to Many
Hubungan ini merupakan hubungan dari satu tabel induk yang dihubungkan tengan banyak tabel anak lainnya,  dimana hubungan yang terjadi berdasarkan atribut kunci yang ada pada tabel induk.

3. Hubungan Many to Many
Hubungan ini merupakan hubungan keseluruhan yang berasal dari banyak tabel yang mempunyai hubungan dengan banyak tabel yang lainnya.
Suatu sistem basis data terdiri dari empat komponen, yaitu :
a. Data yang secara fisik menyimpan informasi – informasi.

b. Database menajemen system (DBMS) yaitu perangkat lunak perangkat lunak yang mengelola basis data.
c. Data Description Language (DCC) dan Data Manipulation Language (DML) yaitu bahasa basis data yang berfungsi untuk mendeskripsikan data ke DBMS dan juga memberi fasilitas untuk perubahan, pemeliharaan, dan pengolahan basis data.
d. Program aplikasi yang memudahkan pengguna akhir untuk menggunakan data dan mendapatkannya sebagai informasi yang sesuai.

Dalam merancang basis data, istilah yang perlu diketahui untuk analisis dan desain sistem antara lain :

a. Entity adalah orang, tempat, kejadian atau konsep yang informasinya direkam.

b. Attribute adalah item data yang menjadi bagian dari suatu entitas.

c. Data value (nilai atau isi dalam) adalah data actual atau informasi yang disimpan pada setiap data elemen (attribute).
d. Record adalah kumpulan elemen – elemen data yang saling berkaitan menginformasikan tentang suatu entity secara lengkap.

e. File adalah kumpulan record – record sejenis yang mempunyai panjang elemen yang sama, attribute yang sama, namun berbeda – beda data valuenya.

f. Database (Basis Data) adalah kumpulan tabel yang mempunyai kaitan (Relasi) antara satu tabel dengan tabel yang lainnya hingga membentuk bangunan data yang mengkonfimasikan suatu intruksi.

g. DBMS adalah komputer file yang saling berkaitan bersama dengan program untuk pengolahannya.
2.6. Sistem Perangkat Lunak

Perangkat yang digunakan Software Microsoft Visual Basic 6.0 dan Microsoft Access 2003, sebagai alat bantu dalam pembuatan program tentang penyewaan VCD pada Wahana Disc. 
Microsoft Visual Basic 6.0 adalah bahasa pemrograman yang digunakan untuk membuat aplikasi Windows yang berbasis grafis (GUI – Graphical User Interface), Visual Basic merupakan event – driven programming (pemrograman terkendali kejadian) dimana program menunggu sampai adanya respon dari pemakai berupa event / kejadian tertentu (tombol diklik, menu dipilih, dan lain – lain).
2.6.1. Microsoft Visual Basic 6.0
Visual Basic 6.0 merupakan bahasa pemrograman yang cukup popular dan mudah untuk dipelajari.  Dengan membuat program  dengan aplikasi GUI (Graphic User Interface) atau program yang memungkinkan  pemakai property berkomunikasi langsung dengan property tersebut. Dengan menggunakan modus grafik atau gambar. Microsoft Visual Basic 6.0 menyediakan fasilitas  yang memungkinkan pengguna untuk menyusun sebuah program dengan memasang obyek - obyek grafik dalam sebuah form. 

 
Visual Basic 6.0 berawal dari bahasa pemrograman BASIC (Beginners All-purpose Symbolic Instruction Code). Karena bahasa basic cukup mudah dipelajari dan popular maka semua programmer menguasai bahasa ini. Tahun 1980-an operasi DOS  cukup popular dikalangan pemakai PC karena didalamnya disertakan bahasa basic  yang dikenal dengan QBASIC (QuickBasic). Sistem tersebut sekarang sudah jarang digunakan. Di era Windows, Microsoft menciptakan Visual Basic yang terus mengalami penyempurnaan hingga Visual Basic 6.0 ini. Ada beberapa kemampuan  dari Visual Basic, sebagai berikut : 
1. Membuat program aplikasi berbasis Windows.
2. Membuat objek-objek pembantu program, misalnya file Help, ActiveX dan sebagainya.
3. Menguji program dan menghasilkan program akhir berekstensi EXE yang langsung dapat dijalankan dari luar Visual Basic.

Dalam pembuatan aplikasi menggunakan Visual Basic, kita akan sering bertemu dengan istilah-istilah yang biasa dipakai dalam lingkungan pemrograman visual, yaitu object, property dan event. Dengan demikian maka pembuatan aplikasi menggunakan Visual Basic dapat dilakukan dengan cepat dan menghasilkan aplikasi yang tangguh yang mampu memberikan informasi secara cepat dan akurat.
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Gambar 2.1. Lingkungan pengembangan aplikasi Visual Basic 6.0

2.6.1.1. Komponen – komponen Visual Basic 6.0 

Microsoft Visual Basic 6.0 mempunyai beberapa komponen yang sangat penting, yaitu :
· Control Menu

Control Menu adalah menu yang digunakan terutama untuk memanipulasi jendela Visual Basic. Dari menu ini bisa mengubah ukuran, memindahkan, atau menutup jendela Visual Basic atau jendela Windows lainnya.

Untuk mengaktifkan Control Menu ini, klik tombol mouse pada pojok kiri atas jendela. Berikutnya akan muncul menu Control Menu, di mana bisa memilih salah satu dari perintah ini:

· Restore: mengubah ukuran jendela  ke ukuran sebelumnya.

· Move: untuk memindahkan letak jendela.

· Size: untuk mengubah ukuran jendela.

· Minimize: untuk meminimalkan ukuran jendela.

· Maximaze: untuk memaksimalkan ukuran jendela.
· Close: untuk menutup jendela.
· 
Menu

Menu Visual Basic berisi semua perintah Visual Basic yang dapat dipilih untuk melakukan tugas tertentu. Isi dari menu ini sebagian hampir sama dengan program – program Windows pada umumnya. Untuk memilih menu, caranya juga sama dengan program Windows lainnya.

· Dengan Mouse:

Klik mouse pada menu dan submenu.

· Dengan keyboard:

Tekan ALT dan karakter bergaris bawah untuk memilih menu. Misalnya ALT+F untuk membuka menu File.



Beberapa perintah juga memiliki shortcut (tombol cepat), seperti misalnya Ctrl+N untuk membuat proyek baru dan sebagainya
· Toolbar

Toolbar adalah tombol – tombol yang mewakili suatu perintah tertentu dari Visual Basic. Setiap tombol tersebut dapat langsung diklik untuk melakukan perintah tertentu.biasanya tombol – tombol ini merupakan perintah – perintah yang sering digunakan dan terdapat pula pada menu Visual Basic. Sebagai contoh, daripada memilih perintah Edit > Copy dari menu, Kita bisa langsung mengklik tombol toolbar Copy
Toolbar yang umum adalah toolbar Standard, Pada Visual Basic 6,0 terdapat berbagai toolbar yang dapat digunakan. Untuk menampilkan macam – macam toolbar yang ada, pilih menu View > Toolbar. Kegunaan masing – masing tombol pada toolbar standard Visual Basic dapat dilihat di bawah ini.
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Gambar 2.2 Toolbar standar Visual Basic.

Tabel 2.1 Kegunaan masing-masing toolbar
	Nomor
	Nama
	Fungsi

	1
	Add Project
	Menambahkan proyek ke dalam proyek yang sudah ada.

	2
	Add Item
	Menambahkan komponen atau objek ke dalam jendela Form

	3
	Menu Editor
	Menampilkan Menu Editor untuk mengubah tampilan menu.

	4
	Open Project
	Membuka proyek Visual Basic yang sudah ada.

	5
	Save Project Group
	Menyimpan proyek Visual Basic pada komputer 

	6
	Cut
	Memotong elemen yang dipilih pada layar.

	7
	Copy
	Meng-copy elemen yang dipilih pada layar.

	8
	Paste
	Menyalin elemen yang sebelumnya sudah dipotong (Cut) atau disalin (Copy).

	9
	Find
	Mencari teks tertentu.

	10
	Undo
	Membatalkan perintah atau tindakan yang terakhir.

	11
	Redo
	Mengulangi perintah atau tindakan terakhir

	12
	Start
	Menjalankan proyek yang dibuat pada Visual Basic

	13
	Break
	Menghentikan running program untuk sementara.

	14
	End
	Menghentikan running program.

	15
	Project Exsplorer
	Menampilkan jendela Project Explorer.

	16
	Properties Window
	Menampilkan jendela Properties.

	17
	Form Layout Window
	Menampilkan jendela Form Layout Window.

	18
	Object Browser
	Menampilkan jendela Object Browser.

	19
	Toolbox
	Menampilkan jendela Toolbox.

	20
	Data View Window
	Menampilkan jendela Data View Window.

	21
	Visual Component Manager
	Menampilkan jendela Visual Component Manager.


· Form Window



Form Window atau jendela Form adalah daerah kerja utama, dimana Kita akan membuat program – program aplikasi Visual Basic. Pada form ini, Kita akan meletakkan berbagai macam objek interaktif seperti misalnya teks, gambar, tombol-tombol perintah, scrollbar, dan sebagainya. Jendela Form ini pada awalnya kelihatannya kecil, tetapi ukurannya bisa diubah-ubah sesuai dengan kebutuhan aplikasi kita.
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                                   Gambar 2.3 Jendela Form.
· Toolbox


Toolbox adalah sebuah “kotak peranti” yang mengandung semua objek atau kontrol yang dibutuhkan untuk membentuk suatu program aplikasi. Kontrol adalah suatu objek yang akan menjadi interface (penghubung) antara program aplikasi dan user-nya, dan kesemuanya harus diletakkan di dalam jendela Form diatas.

Gambar 2.4 Toolbox.
Jendela Toolbox ditampilkan di sebelah kiri layar dan berisi objek-objek standar yang akan selalu muncul setiap kali menjalankan Visual Basic. Kontrol ini terdapat pada semua versi dari Visual Basic 6.0 Kita juga bisa menambahi objek pada Toolbox ini dengan memilih menu Project  > Components.
· Project Explorer

Jendela Project Explorer adalah jendela yang mengandung semua file di dalam aplikasi Visual Basic Kita. Setiap aplikasi dalam Visual Basic disebut dengan istilah project (proyek), dan setiap proyek bisa mengandung lebih dari satu file. Pada Project Explorer ditampilkan semua file yang terdapat pada aplikasi (proyek), misalnya form, modul, class, dan sebagainya.
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                               Gambar 2.5 Jendela Project Explorer.

· Jendela Properties
Jendela Properties adalah yang mengandung semua informasi mengenai objek yang terdapat pada aplikasi Visual Basic. Properti adalah sifat dari sebuah objek, misalnya seperti namanya, warna, ukuran, posisi, dan sebagainya. Setiap objek sebagian besar memiliki jenis properti yang sama, tetapi ada pula yang berbeda-beda.

Kita akan mengatur bentuk dan karakteristik dari setiap objek melalui jendela Properties ini. Di bagian paling atas dari jendela Properties ini terdapat kotak yang menunjukkan nama objek yang sedang aktif, sedang propertinya ditampilkan di bagian bawah dari jendala Properties tersebut.
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Gambar 2.6 Jendela Properties. 
· Form Layout Window
Form Layout Window adalah jendela yang menggambarkan posisi dari form yang ditampilkan pada layar monitor. Posisi form pada Form Layout Window inilah yang merupakan petunjuk di mana aplikasi Anda akan ditampilkan pada layar monitor saat dijalankan nanti.
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Gambar 2.7 Form Layout Window.
· Jendela Code

Jendela Code adalah salah satu jendela yang penting di dalam Visual Basic. Jendela ini berisi kode-kode program yang merupakan instruksi-instruksi untuk aplikasi Visual Basic. Setiap objek pada Visual Basic dapat Kita tambahi dengan kode-kode program untuk melakukan tugas-tugas tertentu, misalnya menutup aplikasi, membatalkan perintah, dan sebagainya.
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                                     Gambar 2.8 Jendela Code.
Pada saat menjalankan Visual Basic, jendela ini tidak akan ditampilkan pada layar. Untuk menampilkannya, ada beberapa cara yaitu:

· Pilih menu View > Code
· Klik ganda objek tertentu pada form window, atau
· Klik kanan pada komponen yang diinginkan, lalu pilih View Code.
2.6.1.2.  Tipe Data dalam Visual Basic 6.0
Visual Basic Mendukung tipe-tipe data seperti dibawah ini
Tabel 2.2 Daftar tipe data Visual Basic
	Tipe Data
	Besar (Byte)
	Jangkauan Nilai

	Boolean
	4
	True atau False

	Byte
	1
	0 sampai 255

	Char
	2
	Karakter Unicode

	Date
	8
	Januari 1,0001 sampai Desember 31, 9999 dan 0:00:00 sampai 23:59:59

	Decimal
	16
	· 0 sampai +/-

79.228.162.514.264.337.593.543.950.335 (Tanpa Nilai Desimal)

· 0 sampai +/-

7,9228162514264337593543950335 (dengan 28 tempat sebelah kanan dari desimal).

· Nilai yang lebih kecil dari 0 :

+/- 0,0000000000000000000000000001 (+/-1E-28).

	Double
	8
	· Negatif

-1.797693134862310.0E308 sampai

-4.94065645841247E-324

· Positif

4.94065645841247E-324 sampai

1.79769313486232E308.

	Integer
	4
	-2,147,483,648 sampai 2,147,483,647

	Long
	8
	-9,223,372,036,854,775,808 sampai

9,223,372,036,854,775,807

	Object
	4
	Semua tipe dapat didimpan didalam variabel object.

	Short
	2
	-32,768 sampai 32,767

	Single
	4
	· Untuk Negatif

-3.402823E38 sampai -1.401298E-45

· Untuk Positif

1.401298E-45 sampai 3.402823E38

	String
	Tergantung Penggunaan
	0 sampai 2 juta karakter unicode


Dalam Visual Basic, sebelum anda dapat menggunakan sebuah variabel pertama anda harus mendeklarasikan variabel terlebih dahulu. Pendeklarasian Variabel dapat dilakukan dengan cara :
“Dim nama variabel as tipe data” 
Contoh : Dim x as integer
Dibawah ini terdapat beberapa jenis atribut dalam Visual Basic
· Attribute Dim

Atribut ini memiliki jangkauan terbatas dan hanya dapat digunakan pada prosedur atau modul tempat variabel dideklarasikan.
· Attribute Protected
Atribut ini juga memiliki jangkauan terbatas, yang dapat mengakses variabel nya hanya dari class yang sama atau dari turunan class yang sama.
· Attribute Friend
Variabel yang dideklarasikan dengan atribut ini dapat diakses dari dalam program atau manapun. Atribut ini tidak dapat digunakan didalam prosedur.
· Attribute Private.
Variabel dengan atribut ini hanya dapat diakses pada modul ataupun class tempat variabel dideklarasikan.
· Attribute Public.
Variabel yang dideklarasikan dengan atribut ini memiliki akses yang bebas dari modul ataupun class manapun.tetapi tidak di prosedur.
Microsoft Visual Basic mendukung berbagai operator, operator-operator yang digunakan dalam Visual Basic adalah:
· Operator Pangkat 

^

· Operator Perkalian

*

· Operator Pembagian

/

· Operator Pembagian Integer
\

· Operator sisa pembagian
Mod

· Operator penjumlahan

+

· Operator Pengurangan
-

· Operator Penggabung String 
( & dan + )

· Operator kurang dari

<

· Operator kurang dari atau sama  <=

· Operator lebih besar dari
>

· Operator Lebih besar dari atau sama
>=

· Operator sama dengan

=
· Operator tidak sama dengan
<>
· Operator Like

· Operator Is

· Operator TypeOf........Is

· Operator And 

· Operator Not

· Operator Or

· Operator Xor

· Operator AndAlso
· Operator OrElse
2.7. Microsoft Access
Database Sistem Informasi penyewaan VCD di Wahana Disc ini selain bisa dibuat dari visual data manager melalui Visual Basic 6.0, bisa juga dibuat langsung dari Microsoft Access 2003.
Access merupakan salah satu program pengolah database yang canggih, yang digunakan untuk mengolah berbagai jenis data  dengan pengoperasian yang mudah. Banyak kemudahan yang akan diperoleh jika bekerja dengan Microsoft Access. Diantaranya anda dapat melakukan  proses penyortiran, pengaturan data, pembuatan label data, serta pembuatan laporan kegiatan sehari-hari. Misalnya, anda dapat menggunakan  Microsoft Access  untuk menampung daftar pelanggan, petugas, dan sebagainya.

Dan sesuai dengan perkembangannya, Microsoft Access 2003 merupakan penyempurnaan  dari program Microsoft Access sebelumnya. Banyak hal baru apabila anda bekerja dengan  Microsoft Access 2003, diantaranya adalah:

· Database windows toolbar untuk mempercepat proses pembuatan, penataan dan pengolahan object  database.

· Fasilitas group untuk mengelompokan  object didalam database.
· Menampilkan sub data pada object table, Query dan form.

· Dan masih banyak fasilitas yang dapat diproleh apabila bekerja dengan Microsoft Access. 
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Gambar 2.9 Tampilan Microsoft Access 2003
2.8. Mengenal SQL (Structured Query Language)
SQL (Structured Query Language) merupakan bahasa standar yang digunakan untuk pengelolahan database. Database dan SQL sangat erat kaitannya, dimana dengan SQL kita dapat mengelola database seperti membuat tabel, menambah, menghapus dan juga menampilkan record dari suatu database yang kita inginkan sesuai dengan kriteria tertentu. Bahasa SQL merupakan bahasa yang berisi pernyataan-pernyataan sederhana yang mudah untuk kita pahami. Seperti SELECT untuk memilih, UPDATE untuk memperbaharui atau DELETE untuk menghapus. Sebenarnya pernyataan SQL itu sendiri dibagi menjadi dua, yaitu : DDL (Data Definition Language) dan DML (Data Manipulation Language).
